Tudn 18 tir ngay 13/9/2021 = 18/9/2021....cceverrerrerrrseessessessessssssessessassssssessessessassses Am nhac khéi 7

TIET 2: ON TAP BAI HAT MAI TRUONG MEN YEU

TAP PQC NHAC: TPN SO 1

I. MUC TIEU:

- HS hoan thién bai hat “Mai truong mén yéu”.

- HS doc dting TDN s6 1.

- HS rén k¥ nang gé dém theo bai hat va bai TBN.

II. YEU CAU —HUONG DAN HOC SINH TU HOC:

- HS 6n bai két hop cac ki nang gd dém theo phéach, nhip .

- HS luyén cao d¢ va tiét tau ctia bai TDNs6 1.
- HS biét két hop cac k¥ ning ning cao:
+ Ghép 101 ca
+ GO dém
+ Panh nhip 2
4
II1. NOI DUNG:

1.0n tap bai hat “ Mai truong mén yéu” :

https://www.voutube.com/watch?v=TRP2sWVmP7g&t=3s

2.Tap doc nhac TPN s6 1:

Ca ngoi T6 quéce
(Trich)

Nhac va loi - HOANG VAN
i  Nhanh - Vui

Tuong lai dang don chd tay em va nof theo budc dan anh.
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Tuong lai dang don cho tay em di xdy dung nudc nha.



https://www.youtube.com/watch?v=TRP2sWVmP7g&t=3s

https://www.youtube.com/watch?v=s-OJtCg9XEY

https://voutu.be/1PicKsncFd§

3.Ciing cb:
- HS biét thyc hién hoan thién bai hat két hop cac k§ nang gé dém theo phéach, nhip.
_ HS biét thuc hién dang cao d6 va tiét thu TN so 1.

- HS biét thyc hién TDN s6 1 két hop cac ki nang gd dém theo phach, nhip, danh
nhip 2

4.
4. Dan do:
- HS chuén bi xem trudc bai ANTT cua tiét 3.


https://www.youtube.com/watch?v=s-OJtCg9XEY
https://youtu.be/1PicKsncFd8

Ho ten HS: ceririiiiiiiiiiiiiiiniineineeiatiatsnssnssnssessesssassnssnssnsonsonsonssns | 01 S
PHIEU HOQC TAP SO 1 MON CONG NGHE 7

(HS xem SGK, trd lo‘{ cdc chd trong va c?an phiéu sé 1_CN7 véo tip d'e hoc bai n‘hé!)
BAI 3: MOT SO TiNH CHAT CHINH CUA PAT TRONG

Muc tiéu ciia bai : Biét duoc thanh phan co gidi ctia dat trong. Cac tri s6 PH cua

dat chua, dat kiém va dat trung tinh. Trinh bay duoc kha ning giit nudc va chat dinh
dudng cua dat tré)ng. Trinh bay dugc khai niém dd phi nhiéu cua dét, néu duoc vai
tro d6 phi nhiéu cua dat ddi v6i ning suat ciy trong.

L. Thanh phin co giéi ciia dat 1a gi?

- Phén ran duoc hinh thanh tir thanh phan .................. va thanh phan ...................
= Phan VO €O GOM CAC AL ...t e
- Thanh phan co gidi ctia dat 13 ti 18 ....oocovvveeeeennn cua cac hat.........ccocceeeienne.
- Tuy ti 1& timg loai hat trong dat ma chia dat thanh 3 10ai:..........ccceveevveeereereeanes

- Do chua, kiém ctia dat Uoc G0 DANG........oveveeeeeeeeeeeeeeeeeeeeeeans
- Pat thuong c6 tri s6 pH tir ........ deén.............

- PatchuacotrisopHtir........ dén.............

- Dat trung tinh c6 tri s6 pH tr ........ dén.............

- Dat kiém c6 tri s pH tir ........ dén...........

I11. Kha ning giit nwéc va chat dinh dudng ciia dat

- it gitr dc nude va cac chat dinh dudng 13 Nhey CAC. ... e,
- Hatcang ............. kha ning gitt nudc va dinh dudng cang tot
IV. Do phi nhiéu ciia dat 1a gi?

- D6 phi nhiéu cua dit 1a kha ning cta dit cung cip du ............ s eeeeeeeennees ,
................................... can thiét cho cay trong dong thoi khong chira cac chat co
hai cho cay.

- Dicéu kién dé€ c6 nang suat cao:



Hotén HS: ...covvvviiniinnnnnnnnns csesessnissessenianas ciesestnasseitasesenisessenssensns | 71 1 DO
PHIEU HQC TAP SO 2 - MON CONG NGHE 7

BAI 3. MOT SO TiNH CHAT CHINH CUA PAT TRONG

(HS lam truc tiép trén phiéu hoc tip sé 2 va nép phiéu sé 2_cong nghé 7 vé cho GVBM vio tudn sau)

BAI TAP: HS chon khoanh tron vao ciu di lwa chon

Céu 1: Pat chua c6 tri s pH la:

A. <6,5
B. >6,5
C. 6,6-75
D. >7,7
Cau 2: Mubn cay tréng cho nang suét cao phai c6 da cac diéu kién:
A. Pit phi nhiéu, giéng tdt, cham soc tot va thoi tiét thuan loi.
B. bat phi nhiéu, cham sdc tot, dieu kién thudn loi va ki thuat tot.
C. bat phi nhiéu, giong tot, bon nhi€u phan va cham soc tot.
D. bat phi nhi€u, bon phan dang ki thuét, thoi tiét thuan loi.
Cau 3: Pt c6 tri sb pH bang 6,8 1a dét:
A. bit chua
B. Dit thit
C. bat trung tinh
D. bat kiem
Céau 4: Can cu vao d6 pH, nguoi ta chia dét thanh cac loai:
A Dat chua, dat sét, dat kiém
B. Pbat chua, dat cat, dat kiem
C. bat chua, dat sét, dat trung tinh
D. bat chua, dat trung tinh, dat kiém

Cau 5: it trung tinh c6 tri s6 pH la:

A. <65
B. > 6,5
C. 6,675
D. >77
Cau 6: Dét c6 tri s6 pH bang 6,4 1a dat:
A. Dé}t chua
B. Dat thit
C. bat trung tinh
D. Pit kiém

Cau 7: Kha ning giit nude cua dat tot nhat la:

A. DAt sét
B.  Datthit
C. Pat cat

Cau 8: Dét c6 tri s6 pH > 7,5 1a dét:

A. Pét chua

B. Dit thit

C. Dit trung tinh
D. Pat kiém



~amET

lUon,  memsmmm—Bai 3. MOT SO TiNH CHAT CHINH CUA DAT TRONG

1. Biét dugc thanh phén co gidi cua dat la gi.
2. Hiéu dugc thé nao Ia dit chua, dat kiém va dat trung tinh.
3. Biét dugc kha niing giir nudc va chat dinh dudng cta dat.
4. Hiéu dugc thé nao Ia dd phi nhidu clia dat

¢ Q@&ﬁ‘éng,OSmm) va sét (nhé hon 0 002mm) Tilé
 sét trong dit tao nén thanh phén co gioi cua dat. :
; ia chia dat lam 3 logu chinh : dat cat, oAl

o bang d6 pH. Tri sé pH dao dong tir 0 dén
€n 9. Can cu vao tr; so pH ng\rbl ta chxa




IV. DO PHi NHIEU CUA AT LAGI

‘\
nudc, oxi va chit ¢, 1. QUY TRI
it cung cip 4 , dong thoi khong

ua d
P§ phi nhiéu cua dat 12 kha nﬁng cua sufit caos
dudng cdn thiét cho cay rong bao dam M
cdc chat ¢6 hai cho cay. éu {6 llyét dinh nﬁng sug
P phi nhiéu cua dat lﬂcbmﬁmg tca 6.1 46 phi nhléu cua dat can phi
n )
cdy trong. Mudn cdy trong gl sbptﬁ;w thwué’tth

¢6 thém cdc diéu kién : giong.




Trwong: THCS Ha Huy Tap Ho va tén giéo vién:
Té: Sir - Pia - GDCD
Tuan: 2. Pia li 7
Bai 3. QUAN CU. PO THI HOA

Noi dung bai hoc

1. Quéan cw ndng thén va quin cu dd thi

- Quan cu ndng thon: Co mat do dan s thap, 1ang mac thon xém thudng phan
tan gan lién véi dat canh tac, dong co, dat rirng hay mat nuéce; dan cu song chu
yeu dua vao san xuat nong, lam, ngu nghiép.

- Quan cu thanh thi: C4 mat d6 dan sé cao, dan cu séng cha yéu vao san xuat
cdng nghiép va dich vu.

- L6i séng nong thon va do thi c6 nhiéu diém khac biét.

2. Do thi hoa. Cac siéu do thi

- D6 thi hda 1a xu thé tat yéu cua thé gidi.

- S6 dan do thj trén the gici ngay cang tang, hién c6 khoang mot nira dan s6 thé
gidi song trong cac do thi.

- Nhiéu db thi phét trién nhanh chong, tro thanh cac siéu d6 thi nhu Bac Kinh,
Tokio, Niu Béli, Luan Pon, Pari, Niu I-ooc...

Cau héi ciing co:

Néu su khac nhau co ban giita quan cu nong thon va quan cu db thi?



Trwong: THCS Ha Huy Tap Ho va tén giéo vién:
Té: Sir - Pia - GDCD
Tuan: 2. Tiét 2 Pia li 7

Bai 4: THU'C HANH: PHAN TiCH LUQC PO DAN SO VA THAP TUOI

1. (Khuyén khich hoc sinh tu 1am)
2. Quan sat 2 thap tudi caa TP HCM qua cac cudc tong diéu tra dan so nam
1989 va 1999, cho biét:
Hudéng dan nhan biét cac bo phan thap tudi:
Tir 0 dén 14 tudi (Pay thap): Dudi d6 tudi lao dong
Tir 15 dén 59 tudi (Than thap): Trong d6 tudi lao dong
60 tudi trg 1én (Pinh thap): Trén do tudi lao dong
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PHIEU HOC TAP

Hinh dang thap tuoi Nhom tudi tang ti ¢ Nhom tuoi giam ti lé
thay doi nhu the nao tu
1989 — 1999




3. Tim trén luoc d6 phan bd dan cu chau A nhitng khu vyc nao tap trung dong
dan? Cac d6 thi 16n & chau A thuong phan bo ¢ dau?




TIET 2.
BAI 2 TRUNG THUTC.

l. N§i dung trong tam.
1. Truyén doc.
“su cong minh chinh truc cia mot nhan tai vi dai”

Mi-ken- Ling- Gio la nguoi thang than,luén ton trong va néi 1én sy that,khong dé
tinh cam cé& nhan chi phdi 1am mat tinh khach quan khi danh gia sy viéc.

2.Noi dung bai hoc
a. Trung thuc

- Luon ton trong su that, chan li, 1€ phai.
*./ Biéu hién :

- Ngay thang, that tha, diing cam nhan 16i khi minh mac khuyét diém.

b.Y nghia :

- Sbng trung thuc gidp ta ndng cao pham gia.

- Lam lanh manh cac mdi quan hé x& hoi dugc moi ngudi tin yéu, kinh trong.
3. Bai tap va van dung.

1. Néu biéu hién hanh vi thiéu trung thuc ?

2. Ngudi trung thuc thé hién hanh dong té nhi, khén khéo ntn ?

3. Ké cau chuyén vé tim guong trung thuc xung quanh em hozc qua béo chi ?



TRUONG THCS HA HUY TAP
NGU VAN 7
Tiét 6: LIEN KET TRONG VAN BAN

A.PHAN 1: HS tra 1oi cau héi trong SGK /17,18 va tra 16i miéng cac ciau héi sau :
1) Theo em, khi doc doan vin, En-ri-cé di cé thé hiéu ré bé muén ndi gi chwa?
2) Néu En-ri-cé chwa hiéu y bd, hiy cho biét li do néo trong cdc li do sau:

- Vi cdu van viét chua dung ngit phap.

- Vi cau van c6 ngi dung chua that ro rang.

- Vi giita cac cau con chua c6 sy gan lién, lién két v6i nhau.
3) Viy muén cho doan vin c6 thé hiéu dwoc thi né phdi cé tinh chit gi?
4) Lién két trong vin bén c6 tic dung gi?
5) Doan van thiéu ¥ gi ma tré nén khé hiéu? Hay sira lai dogn vin dé En-ri-c6 hiéu dwoc
¥ bo?
6) Poc cdc ciu vin sau “Mpt ngay kia...dang mit keo” va chi ra sw thiéu lién két giita
chiing? Hay siva lai dé thanh mét doan vin cé nghia?
7) Tir hai vi du trén, em hiy cho biét mét vin bén cé tinh lién két trwée hét phii cé diéu
kién gi? Cdac cdu van trong van ban phdi sw dung phwong tién gi?

8) Viy yéu cdu ciia vin bdn can phdi cé sw lién két 6 nhitng phwong di¢n nao?

PHAN 2: Néi dung ghi bai ( HS ghi bai hoic in ra déng thanh tip.)

Tiét 6: LIEN KET TRONG VAN BAN

I/ LIEN KET VA PHUONG TIEN LIEN KET TRONG VAN BAN.

1) Tinh lién két trong vin ban:
VD: SGK/17

— Poan van kho hiéu, chua co su lién két.
= Can lam cho ndi dung céc cau, cac doan thong nhat va gan bo chat ché.

* Ghi nhé: SGK/18



2) Phwong tién lién két trong vin bdn
a/ VD: SGK/18

— Chua lién két vé ndi dung.
b/ VD: SGK/18
— Chura lién két vé& hinh thirc.
= Lién két cac cau, cac doan bang nhiing phuong tién ngdn ngi.
*Ghi nh6 : SGK/18
II/ LUYEN TAP: (Khuyén khich hoc sinh 1am bai sé dwoc cong diém)

* Bai tAp tric nghiém

Bai 1: Vi sao cac ciau tho sau khong tao thanh m¢t doan tho hoan chinh?

Ngay xuan con én dua thoi,

Thiéu quang chin chuc di ngoai sau muoi.
Long lanh day nudc in troi
Thanh xay khoi biéc, non phoi bong vang.
Sé sé nim dat bén duong
RAu rau ngon co nira vang ntra xanh

A. Vi chung khéng van véi nhau
B. Vi chung c6 van nhung gieo van khong dang luat
C. Vi chiing ¢6 van nhung y cta cac cau khong lién két voi nhau
D. Vi céc cau tho chua di mot y tron ven
Bai 2: Hay sip xép cdc ciu sau theo mot trinh tw hop 1y dé c6 mdt doan viin hoan
chinh :

Ong dang nam nghi trén givong. (1) Han nhe nhang md ngin kéo ta luc tim tién. (2)
Mot 1an nha van Ban- gidc di nga quén khong dong cira. (3) Bdng han nghe tiéng chu:
“anh ban o1, anh dimg hoai cong tim tién & cai chd ma ngay gitra ban ngay dot dudc toi
cling chang vét ndi mot xu”. (4)

Bai 3: Dong nao néi dung nhat vé lién két trong van ban ?



A. Nguoi ta lién két cac cau bang mdi lién quan cta ndi dung ma ching thé hién, va
cling c6 thé cac phuong tién lién két ctia ngdn ngir dé lién két.

B. Chi c6 cac phuong tién lién két cia ngdn ngit méi c¢6 thé 1am nhiém vy lién két

C. Khong bao gid can cac phuong tién ngdn ngir khi lién két cac cau trong vin ban

D. Cac diu ciu la phuong tién lién két chu yé.

* Bai tap van dung

BT 2,3/18.

* Bai tap mo rong

Viét mot doan van ngin 5-7 cau vé chu dé Tinh cam gia dinh trong d6 c6 st dung phép

lién két va chi ra cac phuong tién lién két.

DAN DO

- Hoc sinh ghi bai, 1am bai day du.
- Nim viing kién thuc noi dung bai hoc.
- Chuén bi bai “B6 cuc trong vin ban”.

Tiét 7: BO CUC TRONG VAN BAN

B. PHAN 1: Hs doc bai “B6 cuc trong vin ban” SGK/28,29,30 va tra 1oi miéng cac ciu
hoi sau:

- Cho HS tim hi€u B0 cuc cta van ban.

1) Em muén viét mét ld don dé xin gia nhip Péi Thiéu nién Tién phong Hoé Chi Minh.
Hay cho biét : Nhitng ngi dung trong don dy c6 cin dwoc sdp xép theo mot trit tw khong?
C6 thé tuy thich muén ghi ngi dung nao truée ciing dwoc hay khéng? (Vi du, cé nén viét
li do khién em muén xin vao Dji trudc, roi méi khai ré ho tén em la gi? Song va hoc &
ddu khéng? Hodc cé nén dwa ra 10 hiva sé tiép tuc phin diu sau khi dwoc két nap vio

Doi truwdc, roi moi néu li do xin vao Doi hay khong? Vi sao?)



2) Sw sdp ddt nji dung cdc phén trong vin bin theo mot trinh tw hop Ii dwoc goi la bo

cuc. Em hay cho biét : Vi sao khi xdy dung vin ban, can phdi quan tim t6i bé cuc?

- Cho HS tim hiéu Nhitng yéu cau vé bd cuc trong vin ban qua viéc doc hai cau chuyén (1),
(2) (SGK/29)

3) Hai cdu chuyén trén da cé bé cuc chwa?

4) Cich ké chuyén nhuw trén bit hop li ¢ ché nao?

5) Theo em, nén sip xép bo cuc hai cdu chuyén trén nhw thé nao?

- Cho HS tim hiéu Céc phan ctia bd cuc trong vin ban.

6) Hay néu nhiém vu ciia ba phin Mé bai, Thin bai, Két bai trong vin ban miéu ti va
van bdn tu su.

7) C6 cdn phan bigt ré rang nhigm vu ciia méi phan khong? Vi sao?

8) C6 ban ndi rang phin M6 bai chi la sw tém tit, rit gon ciia phan Thén bai, con phin

Két bai ching qua chi la sw Igp lai mét lan niva ciia Mé bai. N6i nhw viy cé diing khong?

Visao?

9) Mpt ban khdc lai cho rang ndi dung chinh ciia viéc miéu td, tw sw (ciia don tiv niva)
dwoc don cd vao phin Thin bai nén Mé bai va Két bai la nhitng phan khéng can thiét

lim. Em c6 dong ¥ véi y kién dé khong?
B. PHAN 2: Ndi dung ghi bai (HS ghi bai hoic in ra déng thanh tip )

Tiét 7: BO CUC TRONG VAN BAN

1. BO CUC VA NHUNG YEU CAU VE BO CUC TRONG VAN BAN.

1. Bo cuc cua van ban:

- Noi dung trong mét 14 don can dugc sip xép theo mot trinh ty hop 1y.
- Vin ban phai c6 bd cuc rd rang.

- B cuc 1a su bo tri, sip xép cac phan, cac doan theo mot trinh tu ranh mach va hop 1y.



2. Nhirng véu cau ve bo cuc trong van ban:

Vi du: SGK/29.

— Hai cau chuyén trén chua cé bd cuc rd rang, cacy sap xép 16n xon.

—Yeéu cau vé bd cuc:

- Noi dung cac phan, cac doan trong vin ban théng nhat chit ch&, phan biét ranh mach.
- Trinh ty sap xép hop i.

3. Cac phan ciia bo cuc: 3 phdn

- M& bai: Giéi thiéu van dé.
- Than bai: Trinh bay, giai quyét van dé.
- Két bai: Tong két van dé.
* Ghi nho: SGK/30.
II. LUYEN TAP: (Khuyén khich hoc sinh 1am bai sé dwoc cong diém)

* BT triac nghiém

Cau 1. Bo cuc trong van ban la gi?
A. Van ban khong thé viét mot cach tuy tién, phai c6 bo cuc rd rang

B. B6 cuc 1a su bo tri, sap x€p cac phan, cac doan theo mot trinh tu, mot hé thong ranh

mach va hop 1y

C. Bo cuc la su bo tri, sap xép ndi1 dung cua van ban theo mdt trinh tu, hé thong ranh mach,

hop ly
D. Ca 3 dé4p an trén
Céu 2. Diéu kién nao dé b6 cuc ranh mach, hep 1y?

A. Noi dung cac phan, cac doan trong vin ban phai thong nhat chit ché v6i nhau, bén canh

do, cling c6 su phan biét rach roi

B. Trinh tu xép dit cac phan, cac doan phai giup ngudi viét d& dang dat dugc muc dich giao

tiép dat ra



C. Ca A va B déu dung

D. Ca A va B déu sai

Ciu 3. B6 cuc ciia viin ban dwoc xdy dung gom ba phin: Mé bai, thin bai, két bai
diang hay sai?

A. Dung

B. Sai

Ciu 4. B6 cuc viin ban cudc chia tay cia nhirng con bup bé 1a?

A. Hai anh em chia d6 choi — Thuy chia tay 16p hoc — Canh hai anh em chia tay

B. Thuy chia tay 16p hoc — Canh hai anh em chia tay — Hai anh em chia d6 choi

C. Hai anh em chia tay — Hai anh em chia tay 16p hoc ctia Thiy — Canh chia do choi cua

hai anh em
D. Khong c6 dap 4n nao dung

* BT van dung
Bai 1: Sgk/30.
Vi du cau chuyén “Ech ngdi day giéng” va “Lon cudi 40 méi” 1a vi du vé viée sap xép ¥
khong hop li, hi€u qua cia van ban bi giam sut.
Bai 2: Sgk/30.
B cuc cua truyén "Cudc chia tay ciia nhitng con biip bé" :
- M6 bai: Tir dau... hiéu thao nhu vdy. Canh hai anh em chia d6 choi.
- Thén bai: Tiép... dn trum 1én canh vat. Thuy chia tay 16p hoc.
- Két bai: Con lai. Hai anh em chia tay nhau.

=> B} cuc kha ranh mach va hop li. Mot cach khac, van ban co thé ké theo trinh ty thoi
gian tir qua khir dén hién tai.

* BT mo6 rong



Bai 3: Sgk/30,31.

Phén bd cuc trén chua hop li. C6 thé bd sung nhu sau:

- M6 bai: Thém phan gidi thiéu ho tén, dé tai bao céo sau 15i chao.
- Than bai: Khong nén cho muc (4).

- Két bai: Khai quét lai nhitng kinh nghiém hoc tip da trinh bay.

DAN DO

- Hoc sinh ghi bai, 1am bai day du.
- Nim virng kién thirc ndi dung bai hoc.
- Chuén bi bai: Mach lac trong van ban.

Tiét 8: MACH LAC TRONG VAN BAN

A. PHAN 1: HS doc bai “ Mach lac trong van ban” SGK/31 — 34 va tra loi
miéng cac cau héi sau.
- Cho HS doc khai niém mach lac trong SGK 31.
1. Hay xdc dinh mach lac trong VB c6 nhiing tinh chit gi trong sé cdc tinh chit sau :

+ Troi chdy thanh dong, thanh mach .

+ Tuén ty di qua khap cac phan, cac doan trong VB.

+ Thong sudt, lién tuc, khong dut doan.
2. Mach lac la sw tiép néi ciia cdc ciu, cdc y theo mot trinh tw hop li. Em c6 tin thanh y
kién dé khong? Vi sao ?
3. Viy thé nao la mach lac trong vin bin ?
4. VB “Cudc chia tay cia nhitng con bup bé” ké nhiéu vé cac sy viéc khac nhau nhu: Me
bat hai con phai chia d6 choi; hai anh em Thanh, Thuay rat thwong yéu nhau; chuyén vé hai
con bup bé; Thanh dwa em dén 16p chio cb gido va cac ban; hai anh em phai chia tay; Thuy

dé ca hai con bup bé lai cho Thanh ... Hay cho biét toan bé sw viéc trong VB xoay quanh



sw viéc chinh nao? “Sw chia tay” va “nhitng con bup bé” dong vai tro gi trong truyén?
Hai anh em Thanh, Thiiy cé vai tro gi trong truyén?
5. Trong VB “Cudc chia tay ctia nhitng con bup bé” c6 doan ké viéc hién tai, c6 doan ké
viéc qua khur, ¢c6 doan ké viéc & nha, c6 doan ké viéc & truong, doan ké chuyén hom qua, co
doan ké chuyén sang nay, ... Hay cho biét cdc doan dy dwoc néi véi nhau theo méi lién hé
nao dwdoi day:

+ Lién h¢ thot gian

+ Lién hé khong gian

+ Lién h¢ tam 1y (nhd lai)

+ Lién hé y nghia (twong dong, twong phan)
5. Nhitng moi lién hé giiva cdc doan dy c6 tw nhién va hop Iy khong ?
6. Viy cdc diéu kign dé 1 viin ban cé tinh mach lac la gi?

B. PHAN 2: Néi dung ghi bai (HS ghi bai hodc in ra déng thanh tip )
Tiét 8: MACH LAC TRONG VAN BAN

I. MACH LAC VA NHUNG YEU CAU VE MACH LAC TRONG VAN BAN.

1. Mach lac trong van ban

- Vian ban can phai mach lac.
- Mach lac ¢6 tinh chat thong sudt, lién tuc, khong dut doan.
2. Cic diéu kién dé mot vin ban cé tinh mach lac:

VD: SGK/31,32

— Sur viée chinh: chia tay — chii d& xuyén sudt cta tic pham.
= C6 mot dé tai, mot chu dé chung xuyén sudt va dugc ndi tiép theo mot trinh ty rd rang,
hop 1y .
* Ghi nhé: SGK/32
IL. LUYEN TAP (Khuyén khich hoc sinh 1am bai sé dwoc cong diém)
* BT triac nghiém
Cau 1. Mach lac trong vian ban la gi?

A. Céc phan, cac doan, cac cau trong van ban déu noi vé mot dé tai, biéu hi¢n chu dé
chung xuyén sudt



B. Mach lac 1a sy r6 rang v€ mat ndi dung trong cach trién khai van ban

C. Céc phan doan, cau trong van ban duogc tiép noi theo mdt trinh tu 1o rang, hop li, trude
sau ho ing nham lam rd chu dé lién mach va goi dugc nhi€u hirng tha cho ngudi doc

D.CaAvaC
Cau 2. Diéu kién dé m¢t van ban co6 tinh mach lac?
A. Céc su kién, sy viéc phdi xoay quanh nhitng su kién trong tam

B. Céc phan, c4c doan trong van ban dugc ti€p ndi theo mot trinh tu rd rang, hop 1y, trude
sau ho ing nhau nham lam chu dé 1ién mach va goi dugc nhi€u himg thu cho nguoi doc

C. Cac phﬁn, cac doan, cac cau trong van ban déu noi vé mot dé tai, biéu hién mot chu dé
chung xuyén sudt
D. Ca B va C déu dung

* BT van dung
Bai tap 1/32, 33
a. Tinh mach lac cua VB “ Me t61 ” cia A — mi — Xi
+ Dé tai: Nguoi me.
+ Chu dé: Long yéu thuong va tinh cam sau ning ctia cha me d6i véi con cai.
+ Cac tir ngit, cac cau: thie sudt dém quén quai vi ndi lo sg, khoc nirc nd, bo hét mot nam
hanh phtc, di an xin, hi sinh tinh mang,... thé hién chu dé trén.
+ Cac doan duge lién két chit ché: Mo dau la ly do viét thu. Tiép theo 1a sy tlrc gian cua
ngudi bd va su hét 1ong vi con ciia ngudi me, vai trd va tim quan trong clia me trong cudc
doi. Nguoi bd yéu cau con phai cu xin su tha thir ctia me. Cudi cung 1a hinh phat cta bd
dbi véi con.
+ Céc doan duoc ndi véi nhau theo mbi lién hé thoi gian va y nghia.
b. (SGK/33)
- Dé tai thién nhién
- Chu dé: Sic vang tri phu, ddm 4m cua lang qué “vao mua dong”, “giira ngdy mua”.
- Dan dit theo mot dong chay hop 1y, phi hop véi nhan thic ctia nguoi doc.
+ Cau dau gidi thiéu bao quat vé sic vang trong khong gian lang qué.

9



+ Sau do, tac gia néu 1én cac biéu hién cua sic vang.
+ Hai cau cudi la nhan xét, cam xtc vé mau vang.
* BT mé rong
Bai tap 2/34
Trong truyén “Cudc chia tay ctia nhitng con bup bé”, tac gia da khong thuat lai ti mi nguyén
nhan din dén sy chia tay cta hai nguoi 10n. Theo em, nhu vdy ¢ 1am cho tac pham thiéu
mach lac khong? Vi sao?
DAN DO
- Hoc sinh ghi bai day du, nam kién thirc bai hoc.

- Chuan bi bai méi: “Nhitng cau hat vé tinh cam gia dinh.”

..................... Chic cac em hoc tot! ................

10



Bai 3: Cudc dau tranh cia giai cap tw san chong phong
Kién thoi hau Ki trung dai & Chau Au
1. Phong trio vin héa phuc hung( thé ki XIV - XVII).
a. Khai niém: “Phong trao Van hoa Phuc hung” 1a khéi phuc nhiing tinh hoa van
hoa c6 dai HiLap va R6-ma, ddng thoi phat trién né ¢ timcao méi.
b. Nguyén nhan:
- Ché d6 phong kién kim hdm, vii dap cac gia tri vin hoa.
- Giai cap tu san c6 thé lyc vé kinh té nhung khong ¢ dai vi chinh tri, x& hoi.
c. N9i dung phong trao: ’
- Leén an giao hoi Ki-to, da pha trat tu xa hoi phong kien. ’
- D€ cao gia tri con ngudi, dé cao khoa hoc tu nhién, xay dung the gisi quan duy vat.
d. Y nghia: . ) ) )
- Phat dong quan ching dau tranh chong lai xa hoi phong kién.
- M6 duong cho sy phat trién cua van hoa chau Au va nhan loai.

2. Phong trao Cai cach ton giao:
a. Nguyén nhan: Su thdng tri vé tu twdng, gido i caa ché do phong kién 1a can tré dbi
véi giai cap tu san. Yéu cau dat ra phai tién hanh cai cach.
b. Dién bién:
- Cai cach caa M. Lu-tho (Ptc): Lén an nhitng hanh vi tham lam va doi bai cua Gido hoang,
doi bii bo nhitng thu tuc, nghi 18 phién toai.
- Cai cach caa Can-vanh (Thuy Si): Chiu anh huong nhitng cai cich cta Lu-tho, hinh
thanh mét giao phai mai goi la dao Tin lanh.
c. Hé qua: Pao Ki tb bi phan thanh hai giao phai: Cuu giédo la Ki-t6 giado va Tan ca giao.

Bai 4: Trung Quoc thoi phong kién

1. Xa hgi phong kién & Trung Qudc.

- X3 hoi bién ddi:

+ giai cép dia chu xut hién.

+ Giai cip nong dan bi phan hoa

= Quan hé san xuét phong kién duogc hinh thanh.
2. Xa hoi Trung Qudc thoi Tan — Han;

- Nha Tan thi hanh nhiéu chinh sach ha khic

- Nha Han x6a bé moi chinh sach ha khéc ciia nha Tan.

- Chu trong phat trién kinh té.

- Xam luoc cac nudc khac.

3. Sw thinh vuong ciia Trung Qudc thoi Puong.



Cu nguoi di cai quan cac dia phuong

Mo cac khoa thi tuyén chon nguoi tai.

Giam thué, chia rudng dat(phép quan dién), khuyén khich san xuét.
= Pat nudc phdn vinh moi mit.



PHIEU HQC TAP SO 1_Tin hec 7
Bai thuc hanh 1: LAM QUEN VOI EXCEL
Em hay tra loi c&c bai tap sau day:
Bai 1: Em hdy néu cac cach khoi dong Excel

Bai 7: Em hay cho biét cac budc em can thuc hién trong hop thoai Save As day 1a gi?

Save As @
Save in: I.ij 2_¥L5 files . 3 d-0l Q X L - Tooks~
@]D&ngfkv?muaﬁsach.x\s
u:b @Danh_Muc_Sach.xis
My Recent [ =ps [op A1.xls (1)
Documents )05 lop A2.xs 1 ...........................................................
= E105 lop A3.x1s
9 Epst_k49TH.xs
Desktop @Jburtrufmuafsach.xls (2) ...........................................................
S myFriends. xls
\ @jTinh cach.xls
o 5 3 )
3 (4)
Iy Computer
.:g File name:  [yi_du_1] - Save
Iy Metwork | J | ~
Flaces Save as bype: |Mi:rasoft OFfice Excel Workbook (* xis) L| Cancel




PHIEU HQC TAP SO 2_Tin hec 7
(Em héy trd loi cac bai tdp va nép lai phiéu sé 2 Tin7 cho GV chédm diém vao tuan sau)
Bai thuc hanh 1: LAM QUEN VOl EXCEL
|. Em hay khoanh tron dap 4n dang nhét cho mdi ciu sau:
Cau 1: Dé khoi dong chuong trinh Excel, ta nhay dap chudt vao biéu trong nao sau day?

C.
a2

Cau 3: Thanh cong thirc dugc sir dung dé:
a. Nhap dir liéu vao 6
b. Hién thi cong thirc trong 6
c. Hién thi dia chi 6 c¢6 cdng thirc
d. Dé nhap, hién thi di liéu hoic cong thire ¢ trong d.
Cau 4: Bé mod bang tinh di c6, thuc hién lenh:
a. Nhan t6 hop phim Ctrl + N
b. Insert > Save
c. File > Open
d. Caa,cdéu dung
Cau 5: Dé thoét khoi Excel, ta thuc hién Iénh:
a. Nhan té hop phim Ctrl + Z
b. File > Close
c. File - Exit
d. Cab, c déu ding
Il. Em hiy dién céc thao tac thich hop vao bang dudi déy:

Y nghia Thao tac thuc hién Phim tat

Mg bang tinh mai




Mg bang tinh da co

Luu bang tinh

Pong bang tinh dang mé

DPoéng phan mém Excel




Néi Dung Ghi Bai _ Bai thuc hanh 1: LAM QUEN VOI EXCEL

(HS dan ngi dung ghi bai vao tap dé hoc nhé!)
1. Khéi dong chwong trinh bang tinh Excel:

C1: Start > All Program = Microsoft Office=> Microsoft Excel
C2: Trén man hinh Desktop = Nhay dap chudt vao biéu twong Microsoft Excel
2. Mt s6 thao tac co ban:

% M@ bang tinh mei:

C1: Nhay nut Iénh New I_—hl trén thanh cong cu.
C2: Bang chon File > New
C3: Nhan t6 hop phim Ctrl+N

% Luwu bang tinh:

C1: Nhay nat 1énh Save E trén thanh cong cu.
C2: Bang chon File - Save.
C3: Nhan t6 hop phim Ctrl+S.

% Mé bang tinh da co:

u

C1: Nhay nat Iénh Open lir trén thanh céng cu.
C2: Bang chon File = Open
C3: Nhan t6 hop phim Ctrl+O

% Doéng bang tinh:

- Dong bang tinh dang mé:
C1: Nhan t6 hop phim Ctrl+F4
C2: Nhéay chu¢t vao nat Close Window

- Thoat khoi Excel:

C1: Nhan té hop phim Alt+F4

X .
C2: Nhay chuét vao nut Close . & gbc trén cung bén phai cura s6 lam viéc cua Microsoft
Excel

C3: Bang chon File & Exit



NQI DUNG SACH TIN HOC 7
Tuan 2 (tir 13/9/2021 dén 18/9/2021)

Baitnuc hann 1 ] LAM QUEN VOI
CHUONG TRINH
BANG TINH EXCEL

1. Muc dich, yéu cdu

« Khdi 8dng va két thic Excel.

« Nhan biét cac 6, hang, cit trén trang tinh Excel.

« Biét cach di chuyén trén trang tinh va nhap dif liéu vao trang tinh.

2. Noi dung
a) Khoi dong Excel
Co6 thé khdi dong Excel theo nhiéu cach khac nhau. Cach sau day thuting dutc sif dung:

Nhay chudt trén nut Start, tro vao All Programs va chon Microsoft Excel
(Start — ANl Programs — Microsoft Excel).

Em ciing cb thé khdi dong Excel vai mdt tép bang tinh 33 cb bing cich nhay dip
chudt vao tén tép bang tinh, N&u cb san biéu tuong & trén man hinh, em ciing cb
thé kich hoat biéu tuong dé dé khdi dong Excel.

b) Luu két qua va thoat khoi Excel

o D& luu két qua 1am viéc, chon File — Save hodc nhay nut iénh Save . Cactép
bang tinh do Excel tac ra va ghi lai ¢ phan dudi ngdm dinh 1 xis.

« D& thoat khdi Excel, chon File — Exit hoac nhay nit Bl trén thanh tidu dé.
BAI TAP 1, Khdi dong Excel.
o Liét ké cac diém gidng va khac nhau gilla man hinh Word va man hinh Excel.

» M3 céic bang chon va quan sat cac lénh trong nhilng bdng chon db.

» Kich hoat mdt & tinh va thuc hién di chuyén trén trang tinh bing chudt va bang
ban phim. Quan sat sy thay d6i mau cia cac nlt tén hang va tén cit.



BAI TAP 2. Nhap di liéu tuy y vao mét 6 trén trang tinh. Ding phim Enter d& két
thic viéc nhap dir liéu trong 6 d6 va quan sat 6 duoc kich hoat tiép theo.

Lap lai thao tac nhap dir liéu vao cac 6 trén trang tinh, nhung st dung mét trong
cac phim mdi tén dé két thic viéc nhap dir liéu. Quan séat 6 duoc kich hoat tiép theo
va cho nhan xet.

Chon mét 6 tinh c6 dif liéu va nhan phim Delete. Chon mét 6 tinh khac co di liéu
va gd ndi dung mdi. Cho nhan xét vé cac két qua.

Thoat khéi Excel ma khéng Iuu lai két qua nhap dif liéu em vifa thuc hién.
BAI TAP 3. Khdi dong lai Excel va nhap dit liéu & bang dudi day vao trang tinh:

| A B onl e Gl [ anntins B il Fongl

1 Bang diém l6p 7A

2 st Ho va tén

3 | 1 Binh Van Hoang An

4 2 L& Thi Hodi An

5| 3 L& Théi Anh

8| 4 Pham Nhyu Anh

7] 5 Vi Viét Anh

8 6 Pham Thanh Binh

8 7 Trin Quéc Binh

10 8 Nguyén Linh Chi

‘11 9 VG Xuén Cuong

12 10 Trén Quéc Dat

13 11 Nguy&n Anh Duy

4] 12 Nguyén Trung Diing
Hinh 6

Luu bang tinh véi tén Danh sach lop em va thoat khoi Excel.






TRUONG THCS HA HUY TAP
TO CM: TOAN

SOAN BAI TRUC TUYEN — TOAN 7 ( Tuan 2: Tir 13/9 — 18/9/2021)

e DAISO:

Bai 2: NHAN, CHIA SO HUU Ti

e Sira bai tap: ,
Bai 9/10: Tim x, biét;

1. Nhan hai sé hiru ti:

- Tac6 thé nhan hai s6 hitu ti bang cach viét chung dudi dang hai phan sb, nhan

tr véi tir, nhan mau véi mau.

- Phép nhan s6 hitu ti ¢6 c4c tinh chat cua phép nhan phan s6, nhu: giao hoan,
ket hop, nhan vai so 1, tinh phan phoi gitra phép nhan va phép cong.

- Vidu: Tinh:3,5. (-12)

, 10
2. Chia hai so hiru ti:

- Vi hai sb h&utixzivayzg(qu),taco:

<5}

_ c_a d_ ad

XY=5-37 b c be

- Vi du.Tlnh.Z:(-Z)

_ -5 -1

23 2

_ 9D
23 .2

46

BAI TAP
Bai 13/12 (hs tw giai cau b, d)
13. Tinh:

-38 -7
DT
d)l.[[-—] 4]

23 6/ 18



Giai: o/ =. 2 (=% o (=:3) 2
4 -5 6 12 16 5
—-36 -—-25 11 16 3
=% =(5 339 ¢
_ 9 -25 176 3
=5 e =396 "5
-225 _ —15 43
“ S0~z ~o%
_12_4
T 45 15
Bai 16/13 (hs tw gidi cau b)
16. Tinh:
-2 3Y4 (-1 4) 4 5(1 5
e e ] E R O B e
3 7)°5 L 3 7)5 9'l11 22
., 2, 3, 4 1,4, 4
AR
TR TR
-5 4 5 4
=— -t —=:-
21 5 21 5
:__SE+EE
él 11-5 215 4
=3 Gt
:EO
4
=0

(Lueu v hs ¢0 thé gidi theo cach khac)
BTVN: Bai 1: Thuc hién phép tinh:

1

al 5, (=3) 3

Bai 2: Tim x, biét: a/ ~— 9x == b3 |X+E
4 8 5 4
e Luwu y: Hs lam bai vao giay, ghi ré ho tén, 16p, chup hinh bai lam gui Zalo cho
GV.
HINH HOC:

Bai 2: HAl PUONG THANG VUONG GOC - CAC GOC TAO BOI MOQT

, PUONG THANG CAT HAI DPUONG THANG
1. Thé nao la hai dwong thang vudng gqoc?

Hai duong thang xx', yy' cdt nhau va trong cdc géc tao thanh cé mot goc
vuong duge goi la hai duomg thdng vuong géc va dupc ki hidu la xx' L yy'.

e Minhhoa:




y
Hinh v& trén cho biét hai duong thang xx’ va yy’ cat nhau tai diém O,
duoc ki hiéu la: xx* L yy’

2. Pwong trung truc cia doan thang:

Puomg thdng vubng gbc voi mot doan thdng tai trung diém ciia né duoc
goi la duomg trung truc ciia doan thdng dy.

X

>
|

e Minh hoa: y
= A \ . A? 2 < _ _ ﬁ
Ta co: {4— diém I'la trung diém cua doan thang AB (IA = IB = —)

+ xy L AB tai di€ém I
Nén dwong thdng xy la dwong trung truc ciia doan thang AB
3. Céc gbc tao béi 1 dwong thing cit hai dwong thang:
- O hinh 9, ta thdy duong thing ¢ cat dudng thiang a tai diém A va cat duong
thang b tai diém B.

Quan sat hinh 9, mdi céip goc gom mét goc & dinh A va mot goe & dinh B :

a) Hai goc A, va B, (tuong tw: A, va B,) goi la hai goc so le trong.

b) Hai géc A, va B, (tuongtu: A, va B, : A, va B,; A, va B,) goi la hai goc do:ng Vi.
c) Hai goc A, vaB, (twong ty: A, va B,) goi la hai goc trong cung phia.

C

1\2
& 4\3

1\2
B 43

Hinh 9



. Tinh chat:
Néu du'()'ng thang ¢ cat hai dwong thang a, b va trong cdc goéc tao thanh cé6 mét cap goc so
le trong bang nhau thi :

a) Hai goc so le trong con lai bang nhau.
b) Hai goc dong vi bang nhau.
¢) Hai goc trong cung phia bu nhau.
i BAI TAP: 7
Bai 1: Cho doan thang MN dai 6¢cm, vé duong trung truc cua doan thang MN
X

M Vi P / N
v va Vi .

7 DPuong tt qy ; :ﬁy 1a duong trung tryc cia doan thang MN
Bai 2: Ké tén cac cap goc sc_- _ohg, dong vi, trong cung phia ¢ hinh dudi day:

C

) d

4. lj h

(Hs tu néu ra)
e BTVN: 1/ Cho doan thang EF dai 7cm. V& dudng trung truc cia doan thang EF.
2/ Cho hinh v& sau, néu tén 2 cap goc dbi dinh, 2 cip goc ké bu, 2 cap
goc soletrong, 4 cip goc dong vi, 2 cap goc trong cing phia




e Luwu y: Hs 1am bai vao giy, ghi rd ho tén, 16p, chup hinh bai 1am gui Zalo cho
GV.



Grade 7
Unit 1

BACK TO SCHOOL

A. Eriends
l. Vocabulary
1. parent (n.) — parents

2. still (adv.): van
3. different (adj.): khac — difference (n.): su khac biét

4. unhappy (adj.) # happy (adj.)
— happiness (n.)

5. miss (v.): nho, bo 16

1. Grammar: too, so: used to agree with a positive idea.

e Too: at the end of a sentence.

E.g.: Nice to meet you. - Nice to meet you, too.
| am in grade 7. - | am, too.

e So: at the beginning of a sentence (with inversion).

E.g.: I like chicken. - So do I.
I amin class 7A. - So am |.

I11. Practice: too, so

We should do homework, and should they.
Lan likes apples, and her mother does,
My father is watching TV, and IS my mother.

He goes jogging every day and his son does,
Oranges are good for our health. are apples.

agbrwhE



Grade 7
Unit 1
BACK TO SCHOOL

B. Names and addresses

IV. Grammar:

How far is it from ... to ...? = WAhat is the distance between ... and ...?

-2 It's ... (kilometers/meters).

E.g.: How far is it from here to your school? (What is the different between
here and your school?)

- It is 2 kilometers.

\ How do you go/travel to...? = | go/travel to ... by ... .

E.g.: How do you travel to your friend’s house?

—> I travel to my friend’s house by bus.



Truong THCS Ha Huy Tap
Ho tén: Lop:
PHIEU HQC TAP
LOP 7-MON VAT LY

* Phan 1: Noi dung ghi vé ciia hoc sinh

Bai 2: SU TRUYEN ANH SANG
|. Pwong truyén ciia anh sing
Binh luat truyén thang cta anh sang: Trong méi triong trong suét va déng tinh, anh sang
truyén di theo dwong thang
(cdc moi trieong trong suét nhuwe: thity tinh, nwée, khong khi ...)
Il. Tia sdng, chum sang
a) Tia sang
- Puong truyén cta anh sang dugc biéu dién bang mot duong thang ¢6 mdi tén chi hudng
goi la tia sang.
Biéu dién tia sang: =

b) Chum sang
- Chum sang gdm nhiéu tia sang hop thanh.
- Co ba loai chum sang:
+ Chum sang hoi tu gdm céc tia sang giao nhau trén duong truyén cta ching.

=

+ Chum sang phan ki gom céc tia sang loe rong ra trén dudng truyén cua ching.

<

+ Chum sang song song gom céc tia sang khong giao nhau trén duong truyén cta ching.

* Phan 2: Hwéng dan tra 1oi cau hoi SGK
C1: Anh sang tir ddy toc bong dén truyén truc tiép dén mat theo éng thing
C2: 315 A,B,C cling nam trén mot dudng thang (Dung 1 thanh thang kiém tra)
C3: + Chum sang hoi tu gdm céc tia sang giao nhau trén dudng truyén cua chiing.
+ Chum sang phan ki gém cac tia sang loe rong ra trén duong truyén cia chl'mg
+ Chum sang song song gom cac tia sang khong giao nhau trén duong truyén cta chung.
C4: Anh sang tir dén pin phét ra da truyen dén mit ta theo duong thang
- P4t mat sao cho chi thdy kim gan mat nhat ma khong nhin thay 2 kim con lai.
- Giai thich: Kim 1 1a vat chan sang caa kim 2, kim 2 12 vat chan sang cua kim 3.
Do &nh sang truyén theo dwong thang nén anh sang tir kim 2, 3 dén mit bj cay kim thir 1
che khuat.



* Phan 3: Bai tip vin dung

1. Dién tir vao cho trong:

- Trong moi truong .................. VA i, , anh sang truyén di theo duong thang

- Cac mOI trrdNG troNG SUST NI .....oevee et

e et et duoc biéu dién bang mot duong thang c6 miii tén chi
huonggoila.....................

- M6t cham sang hep gém nhiéu tia sdng song song cd thé coi A mét................

- Chim sang gdm nhiéu ................. hop thanh.

* C6 ba loai chum sang:

- Chim séng hoi tu gom CAC tia SANG ....eevveeveneeieeeeeeen. trén dudng truyén caa chang.
- Chim séng phan ki gdm cac tia SANG ... .eevveeeeeneeennn trén dudng truyén cua chang.
- Chim séng song song gom CAC tia SANG .........eevveeevenn..... trén dudng truyén caa chang.

2. Phat biéu dinh luat truyén thing caa anh sang ?

............................................................................................................

............................................................................................................



TRUONG THCS HA HUY TAP

SINH HQC 7

A. Bai hoc

Kiém tra bai cii

Cau 1: Pong vat va thuc vat giéng nhau ¢ diém nao?
A. CAu tao tir té bao

B. Lén Ién va sinh san

C. C6 kha nang di chuyén

D. Ca AvaB dung

Cau 2: Pong vat da sé khong c6?
A. H¢ than kinh

B. Giac quan

C. Kha nang di chuyén

D. Tu san xuat dugc chét hitu co

I. Trung roi xanh

CAu 1: Trung roi thwong tim thay ¢ dau?
A. Trong khong khi

B. Trong dat kho

C. Trong co thé nguoi

D. Trong nudc

Ciu 2: Bao quan nao ciia trung roi xanh c6 vai tro bai tiét va diéu chinh ap suat thAm
thau?

A. Mang co thé

B. Khéng bao co bop

C. Nhén

D. Hat diép luc

Cau 3: Hinh thirc sinh san ctia trung roi xanh?
A. Vo tinh

B. Hitu tinh

C. Ca 2 hinh thtrc trén

D. Khong sinh san

Cau 4: Khi trung roi xanh sinh san thi by phan phan doi truwéc 1a?
A. Nhan té bao
B. Khdng bao co bdp




C. Chat nguyén sinh
D. Roi

I1. Tap doan trung roi

Cau 5: Tap doan trung roi la hinh anh ciia mo6i quan hé vé ngudn goc giira?
A. Cac Bong vat don bao voi nhau

B. Cac dong vat da bao vo1 nhau

C. bong vat don bao va dong vat da bao

D. Khong c6 cau tra 161 dung

II1. Trung bién hinh va Trung giay

CAu 6: Trong cac phat biéu sau, phat biéu nao sai?
A. Trung giay di chuyén nho 16ng boi

B. Trung bién hinh luén bién doi hinh dang

C. Trung bién hinh c6 16ng boi hd tro di chuyén

D. Trung giay c6 hinh dang nhu dé giay

Cau 7: Trong cac dic diém dwdi dy, dic diém nao cé ca ¢ trung giay, trang roi va
trang bién hinh?

A. Co thé ludn bién d6i hinh dang

B. Co thé ¢6 ciu tao don bao

C. C6 kha nang ty dudng

D. Di chuyén nho 16ng boi

Cau 8: Dudi day 1a 4 giai doan trung bién hinh bat mdi va tiéu hoa mdi:
(1) : Hai chan gia kéo dai nudt mdi vao sau trong chat nguyén sinh.

(2) : Lap tirc hinh thanh chan gia thir hai vay 1ay moi.

(3) : Khong bao tiéu hoa tao thanh bao 1y moi, tiéu hoa moi nhd dich tiéu hoa.
(4) : Khi mot chan gia tiép can moi (tao, vi khuan, vun hiru co...).

Em hiy sap xép cac giai doan trén theo trinh ty hop 1y ?

A.(4)-2)-1)-3

B.(4)-(1)-(2)-(3)

C.3-2-0)-@

D.49-3)-M1-@

Cau 9: Hinh thitc dinh dudng ciia tring bién hinh 13?
A. Tu dudng

B. Di dudng

C. Ca A va B déu ding

D. Ca A va B déu sai




Céu 10: Qua trinh tiéu hoa thirc fin ciia trung bién hinh 14?
A. Tiéu hoa nodi bao

B. Tiéu hoa ngoai bao

C. Ca A va B déu ding

D. Ca A va B déu sai

Cau 11: Trung giay lay thirc in don vé 16 miéng nho?
A. Chan gia

B. Long boi

C. L thoat

D. Khoéng bao co bop

Céu 12: Hinh thirc sinh san cia trung giay 1a?
A. Phan doi

B. Tiép hop

C. bé con

D. Ca A va B déu ding

Cau 13: Trong cac dong vat nguyén sinh sau, ddng vt nio sinh san vé tinh bing cach
phén déi theo chiéu ngang?

A. Trung roi xanh

B. Trung bién hinh

C. Trung giay

D. Ca A, B, C déu ding

Cau 14: Qua trinh tiéu hoa thirc fin ciia trung giay dién ra theo?

A. Thirc an —> khéng bao tiéu hoa —> ra ngoai moi noi

B. Thirc an —> miéng —> hau — thuc quan —> da day —> hau moén

C. Thirc n —> mang sinh chat —> chét té bao —> tham thiu ra ngoai

D. Thirc an — miéng —> hau —> khdng bao tiéu hda —> khéng bao co bop —> 16 thoat

Céau 15: Trong cac dong vat nguyén sinh sau, dong vat nao cé hinh thirc sinh san hiru
tinh?

A. Trung giay

B. Trung bién hinh

C. Trung roi xanh

D. Khéng c6 céu tra loi ding

B. Bai ghi vao vé
CHU PE: PONG VAT NGUYEN SINH (2)
I. Trung roi xanh




- Tring roi xanh 1a dong vat don bao, di chuyén nho roi.

- Dinh dudng: Tu dudng va di dudng.

- H6 hip qua mang co thé.

- Bai tiét va diéu chinh ap suit thim thau nhd khong bao co bop.

- Sinh san vé tinh bang cach phan déi co thé theo chiéu doc.

I1. Tap doan trung roi

Tap doan trung roi du c6 nhiéu té bao nhung van chi [a mot nhom dong vat don bao vi mdi
té bao van van dong va dinh dudng doc 1ap. Ching goi ra mdi quan hé vé ngudn géc giira
dong vat don bao va dong vat da bao.

IIL. Trung bién hinh va Trung giay

Trung bién hinh Trung giay
Gom 1 té bao c6 cau tao rat don | Gom 1 té bao di phan hoa thanh
z gian nhiéu bo phan: Nhan 16n, nhan
Cau tao , i . , .
nho, khong bao co bop, miéng,
hau.
Di chuyén va | Nho chan gia Nho 16ng boi
bit moi
- Tiéu ho4 ndi bao - Thitc 4n qua miéng toi hau toi
- Baj tiét: chat thira dugc tap | khong bao tiéu hoa va bién doi
Dinh dudng tru?rﬁg dén k‘hﬁan bf":lo ‘co,bép va | nho enzyme. o
thai ra ngoai & moi vi tri. - Chat thai dugc dua dén khong
bdo co bop va qua 16 dé thoat ra
ngoai.
- V6 tinh bang cach phan d6i co | - Vo6 tinh bang cach phan d6i co
Sinh san thé thé theo chiéu ngang.
- Hitu tinh bang cach tiép hop
C. Dan do:
- Hoc bai

- Xem trudc bai mai




